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Introduction 
This user guide describes the functionality of the AliveDrive Desktop R1.1 desktop application available for 
Windows 11. 
The application enables owners of vehicles equipped with Cosworth’s AliveDrive system to view and analyse 
their outing recordings outside the vehicle, and provides a way to share the content with others. 

What vehicles are supported? 

In release 1.1, only recordings from vehicles equipped with Enhanced Performance Data Recorder (third-
generation PDR) are supported. 
 
The third-generation, Enhanced PDR (a.k.a. PDR 2.5) is available on the following models: 

• 2026 and later Corvette 
• 2025 and later Cadillac CT5 V-Series & CT5-V Blackwing 

 

Getting Started 

Download and Member Portal 

The AliveDrive Desktop application is available for download via the Cosworth Member Portal. The portal, 
accessible via the main Cosworth homepage, is your gateway to the latest in software available from 
Cosworth. Here you can download and subscribe to Cosworth’s data analysis applications, access product 
updates, software releases, and technical documentation, and stay informed with the latest development 
news. The Portal also provides a central location for support, ensuring you always have the tools and 
information needed to extract maximum performance from your Cosworth-equipped vehicle systems. 
 

 
Figure 1 - Cosworth Member Portal 

 
Once access to the portal is set up, the application download is available from the AliveDrive Desktop 
product page. The application can be downloaded for both Windows and macOS via dedicated download 
buttons. 
 
 
 

https://members.cosworth.com/
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Installation 

The Windows application is designed and tested for deployment on Windows 11 target machines. The MSIX 
installer provides guidance on the installation steps. 
 

Microsoft Windows Desktop Runtime 

You will need to have the .NET desktop runtime installed in order to run the AliveDrive Desktop application.  
You will be prompted, if necessary, during installation to either install the .NET runtime, or upgrade it to 
version 10.  

 

 
Figure 2 – Windows Desktop Runtime requirement 

 
 
Once this is done, the AliveDrive Desktop application can be opened. 
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Licensing Agreement 

The licensing agreement is presented during the installation; acceptance is required in order to proceed to 
use the application. The installation of a licence key is not required, and the application does not require a 
payment for use. 

 
Figure 3 - Licence Agreement 

 
Acceptance of the agreement is only required for the initial installation, and when the licensing terms get 
updated. Re-acceptance is not required each time the application is loaded or when the application is 
updated.  
 
The Licensing Agreement is available here should reference to it be required at a later date. 
 

  

https://www.cosworth.com/motorsport/support/alivedrive-data-analysis-tools/alivedrive-desktop-licence/
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Application Navigation and User Interface 
 

 
Figure 4 – Application Launch 

 
The main menu provides centralized navigation for outing selection, playback, export, and application 
settings/information. A link to the help resources is also available via the menu. 
 
Once an outing is opened, playback controls for play, pause and skip are provided via a scrubber bar., and a 
lap breakdown and lap selector is shown: time per lap plus indicators for fastest and selected laps. 
 

Mouse Controls 

Mouse actions are used for the majority of menu selection and button control of the application. In addition, 
a mouse drag-and-drop can be used, refer to section File Management and Outing Operations 

Keyboard Shortcuts 

Shortcut Description 
CTRL-O File > Open Outing 
CTRL-W File > Close Outing 
Spacebar Control of play/pause function during playback 
CTRL-P Play 
CTRL-SHIFT-RIGHT Step forward 10s during playback 
CTRL-SHIFT-LEFT Step backward 10s during playback 
CTRL-LEFT Go to Previous Lap 
CTRL-RIGHT Go to Next Lap 
CTRL-SHIFT-DOWN Mute audio 

 

Settings 

The app has its own settings for speed, distance, time format and temperature units with three options: 
• UK 
• Metric 
• US Customary 
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The app will default to the location based on the regional settings of the device hosting the app, but this 
default can be over-ridden via the menu. 
 
Speed and distance values displayed within the app including those displayed on the outing overlays are 
adjusted according to the chosen setting. 
 
 

Light/Dark mode 

The appearance of the app can be adjusted according to light/dark mode settings of the device. 
 

 
Figure 5 - Dark Mode 

 

Audio 

The on/off control of audio playback is provided in the playback bar. The application utilises the device 
settings for choice of audio output device and volume.  
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File Management and Outing Operations 
The outing files from the vehicle need to be copied from the SD card to a suitable Windows device folder or 
personal cloud storage area. 
 
Outings can be opened via the menu , or via a drag and drop action from Windows File Explorer into the 
application window.  

 
Figure 6 - Opening an outing using the menu 

 
Figure 7 - Attempt to open an un-supported outing file 

To switch between outings, the user can first close the original outing then open the new outing, or can 
simply open the second outing to effect the switch. The application remembers the previous path used to 
open an outing so that quick outing choice is enabled when outings are all stored centrally. 
 

Drag and Drop 

When the application is first opened, and an outing has not yet been selected, an outing can be selected and 
dropped within the Application Window to open it.  
To drag and drop a new outing to replace an already open outing, you must drag/drop onto the video panel 
and not the explorer bar where the laps are shown. See the figure below. 
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Figure 8 - Drag and Drop to within the red zone to swap outings 

 

Recall of Recently Opened Outings 

The application remembers the most recently opened outing files to enable easier access to recent outings. 
Recently opened outings can be re-opened via the menu. The recently opened outings list can contain a 
maximum of five entries, and can be cleared if required. 

Outing types supported 

All types of outing can be opened for playback and export – circuit, autocross and dashcam.  
Currently, only outings recorded with latest generation, Enhanced PDR (PDR 2.5) AliveDrive systems are 
supported1.   

 
1 PDR v1 and v2 outing file support provided in a later release. Until that release becomes available, the original Cosworth 
Toolbox application should be used for outings recorded in previous generation PDR systems. 
 

https://www.cosworth.com/motorsport/products/cosworth-toolbox/
https://www.cosworth.com/motorsport/products/cosworth-toolbox/
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Playback 
With an outing file loaded, the outing video is presented along with basic outing properties (name, date, 
time) and a breakdown of the outing into laps (for circuit outings). By default, for a circuit outing, the 
playback position will be set to the beginning of the fastest lap (marked with *) within the outing. 
 
Single lap or full outing playback is supported.  
 
The PDR 2.5 outing files comprise video/audio and separate data overlays. The overlay toggle button can be 
used to switch between any available overlay. Overlay choices presented are determined by the vehicle type 
used to make the recording. 
 

 
Figure 9 - Playback, circuit outing example, fastest lap is lap 1, lap 3 selected 

Lap Selector 

The lap selector enables a choice of lap to be made for playback when a circuit outing with multiple laps is 
opened. For circuit outings, the fastest lap is chosen by default (indicated by a *). In the initial application 
release, for autocross and dashcam outings, the outing will open with the lap selector showing a single lap – 
this ‘lap’ being the whole outing. 
 
For circuit outings it is possible to play a single chosen lap or the full outing. 

• Choose a single lap – playback will be set to beginning of chosen lap, and extent of playback will be 
the single lap 

• Un-select all laps – whole outing playback mode 
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Partial Region (Inlap/Outlap) Display 

By default, the lap selector will only show the timed, full laps for selection in the lap selector. Using the 
Options menu, it is possible to toggle the display to show the partial laps in addition. 
 
The Partial Regions are those where the timing does not include the full start line to finish line region: 

• For circuit outings – the inlap and outlap, or the partial laps where the lap timing was incomplete 
due to the vehicle stopping or going off track. 

• For autocross events – the staging and return to paddock regions 
 

 

 
Figure 10 - Control the display of inlap/outlap 

 
Figure 11 - Circuit Outing showing Inlap/Outlap available for playback 
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Playback Control 

Playback is controlled using the playback bar. A toggle button enables the adjustment of the displayed 
overlay. By default, the overlay will be set according to the outing type opened: 
 

• Circuit outing - defaults to ‘Track’ overlay  
• Autocross outing - defaults to ‘Track’ overlay 
• Dashcam outing defaults to ‘None’ 

 

 
Figure 12 - Playback bar example, Sport overlay selected, audio set to 'on' 

 

 
Figure 13 - Playback bar example, scrubber marker part way through lap, elapsed lap time shown, Track overlay selected, 

audio set to 'off' 

 
Playback of audio from the outing can be toggled on/off within the app. Volume control of the audio is 
handled by the device settings, not within the app. 
 

Menu Control of Playback 

 
Figure 14 - Playback control via the menu 
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Export 
Outings from Enhanced PDR systems (PDR 2.5 outings) have dynamic overlays where the overlay data is held 
separate to the outing video/audio. This enables full control in the creation of videos for sharing with the 
overlay choice made at time of export, and not pre-set when the outing recording was captured.  
 
With an outing open for playback, an export function can be initiated from the menu.  
 
If an outing has been under analysis in the application, and choices made as to lap and overlay choice, then 
these choices will be carried across to the export function to enable quick export of the part of the outing 
that was being analysed. The export function allows these defaults to be freely adjusted. 
 
Export setup and preview is provided via a pop-up window. The ‘Settings’ tab covers the choices to be made 
for the export, the ‘Preview’ tab allows a preview of the export to be done as a final check before the export 
action is initiated. 

 
Figure 15 - Export opens up in a separate window 

 

Types of export 

Support for three types of export is provided: 
• Whole Outing export 
• Single Lap export 
• Multi-lap export 

 
A multi-lap choice needs to be sequential laps. 
 
Choice of overlay is made in the settings panel. 
 

 
Figure 16 - Export settings window 
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Export Preview 

The Export Preview panel enables the user to 
see the chosen export settings, and an estimate 
of export file size. 
 
In addition, full and independent playback of 
the export is possible from the Preview panel, 
without affecting the playback in the main 
application window. 
 
Note that if silent preview is chosen (audio = 
OFF in the preview window), this will not affect 
the inclusion of audio within the exported file. 
Exported files will always include audio. 
 

 
Figure 17 - Export Preview 

 
 

Export Progress 

With the export setting choices made, the ‘Export’ button will initiate the process. 
 

 
Figure 18 - Export selected lap(s) 
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Figure 19 - Export Progress 

The native file management application is then used to decide upon export location, and export filename. A 
default filename for the export is chosen, derived from the source outing name for clarity, but this name can 
be over-ridden. 

 
Figure 20 - Export location and filename choice 

The application also has a built-in check for sufficient disk space and will provide warnings if the chosen 
location does not have sufficient space for the export. 
 
The export file is of MP4 format and includes the selected video/audio and chosen overlay data. The file can 
be played on all mainstream video player apps and is suitable for upload for sharing to social sites. 
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Software Updates and Stability 
A manual check for updates can be initiated. The current version can be found via the ‘Help’ menu item. The 
information regarding available app versions inclusive of release notes is available on the Cosworth website , 
on the AliveDrive Desktop product page. 
 
The app has built-in stability monitoring that constantly captures analytical data. This data is anonymised, 
and is solely used to provide feedback to aid diagnostic analysis and bug fixes in the case of app crashes. In 
the situation where an app crash is experienced, the app will send the data to Cosworth with the ability for 
the user to add any additional notes to the report. 
 

Support 
For further assistance in using the application or the in-vehicle AliveDrive system, please refer to the 
Cosworth Support Forum: 
 
Customer Support 
 

https://www.cosworth.com/motorsport/products/alivedrive-desktop/
https://www.cosworth.com/motorsport/support/support-forum/

